
StreetPilot® c550™

owner’s manual



© 2006 Garmin Ltd. or its subsidiaries

Garmin International, Inc. 
1200 East 151st Street,  
Olathe, Kansas 66062, U.S.A. 
Tel. 913/397.8200 or 800/800.1020 
Fax 913/397.8282

Garmin (Europe) Ltd. 
Unit 5, The Quadrangle,  
Abbey Park Industrial Estate,  
Romsey, SO51 9DL, U.K. 
Tel. 44/0870.8501241 
Fax 44/0870.8501251

Garmin Corporation  
No. 68, Jangshu 2nd Road,  
Shijr, Taipei County, Taiwan 
Tel. 886/2.2642.9199 
Fax 886/2.2642.9099

All rights reserved. Except as expressly provided herein, no part of this manual may be reproduced, copied, transmitted, 
disseminated, downloaded or stored in any storage medium, for any purpose without the express prior written consent 
of Garmin. Garmin hereby grants permission to download a single copy of this manual onto a hard drive or other 
electronic storage medium to be viewed and to print one copy of this manual or of any revision hereto, provided that 
such electronic or printed copy of this manual must contain the complete text of this copyright notice and provided 
further that any unauthorized commercial distribution of this manual or any revision hereto is strictly prohibited.

Information in this document is subject to change without notice. Garmin reserves the right to change or improve its 
products and to make changes in the content without obligation to notify any person or organization of such changes 
or improvements. Visit the Garmin Web site (www.garmin.com) for current updates and supplemental information 
concerning the use and operation of this and other Garmin products.

Garmin®, MapSource®, and StreetPilot® are registered trademarks and c550™ is a trademark of Garmin 
Ltd. or its subsidiaries and may not be used without the express permission of Garmin.

SiRF, SiRFstar and the SiRF logo are registered trademarks of SiRF Technology, Inc. SiRFstarIII and 
SiRF Powered are trademarks of SiRF Technology, Inc.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks by 
Garmin is under license. Other trademarks and trade names are those of their respective owners.

March 2006 Part Number 190-00642-00 Rev. A

www.garmin.com


Garmin © 2005 i c550 Owner’s Manual

PREFACE

Quick Links
• Finding an address: page 5

• Viewing the Map page: page 13

• Using hands-free cell phone: 
page XX

• Listening to MP3 files: page 25 

• Transferring files to your c550: 
pages 17–20 and page 55

• Adjusting the volume: page 5

• Adjusting the brightness: page 5

• Cleaning and storing your unit: 
pages 52–53

• Tips and Shortcuts: page 5

PREFACE

Congratulations on purchasing the Garmin® StreetPilot® c550™. 

Serial Number
Record the serial number (8-digit number on the back of the unit) 
in case your c550 needs service or you want to purchase additional 
maps. 

Serial Number: ___ ___ ___ ___ ___ ___ ___ ___

Contact Garmin
Contact Garmin if you have any questions or if you should 
encounter any difficulty while using your c550. 

In the U.S.A, contact Garmin Product Support by phone at 
913/397.8200 or 800/800.1020, Monday–Friday, 8 AM–5 PM 
Central Time. To send us a question through e-mail, go to  
www.garmin.com/support/ and click Technical Support.  
Fill out the form and click Submit .

In Europe, contact Garmin (Europe) Ltd. at 44/0870.8501241.

Tell us how you like this 
manual! Fill out the Product 
Documentation Survey. Go 
to http://www.garmin.com/
contactUs/ and click Product 
Documentation Survey. 

www.garmin.com/support/
http://www.garmin.com/contactUs/
http://www.garmin.com/contactUs/
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FIND IT AND GO!

FIND IT AND GO!
Go outside where you have a clear view of the sky to get satellite signals. Turn on your Garmin StreetPilot 
c550 to begin acquiring GPS satellite signals. The bars in the upper-left corner  indicate satellite 
strength. After your c550 has acquired satellite signals, find your destination and go to it.

Finding Your Destination

Touch Food, Hotels…. 

➋

Enjoy the route! 

➏

Touch Go!

➎

Touch  Where to?

➊

Touch a destination. 

➍

Touch a category. 

➌

✔ TIP: Touch  and  to see more choices.
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FIND IT AND GO!

Following Your Route
Follow the route to your destination using the Map page. As you travel, your c550 guides you to your 
destination with vocal prompts, turn arrows on the map, and directions at the top of the Map page. If you 
depart from the original route, your c550 recalculates the route and provides new route directions. 

Your route is marked 
with a magenta line.

Follow the arrows as 
you make turns.

A checkered 
flag marks your 
destination.

Read the driving 
instructions at the 
top of the page.

For more information about using the Map page, see pages 13–16. 

Taking a Better Route
As you get closer to the destination the c550 evaluates more road options when calculating the route, 
which may result in a better route than what was originally calculated. When the StreetPilot has found a 
better route, a yellow diamond with a road in it  is displayed in the lower-left corner of the Map page. 
Touch  to take the better route. 

If you need to take a detour, press the Menu button to open the Menu page and touch Detour. 
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FIND IT AND GO!

Adding a Stop to Your Route
You can add a stop (via point) to your route. The c550 gives you 
directions to the stop and then to your final destination. 

With a route active, touch 
Menu >  Where to? 

Touch Yes to add this stop 
before your destination. 
Touch No to make this 
your new final destination

Search for the extra stop.

Touch Go!

➌

➋

➍

➊

 NOTE: You can 
add only one stop to 
your route.
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FIND IT AND GO!

Touch Menu to return to 
the Menu page.

➊

Touch Stop to end 
navigation. Touch Detour 
and your unit creates a 
new route if possible.

➋

Adding a Detour to a Route
If you need to take a detour from your current route, touch 
Detour from the Menu page of the c550. The unit calculates 
a new route and provides you with new instructions. The c550 
attempts to get you back on your original route as soon as possible.

On some routes, the route you are currently taking might be the 
only reasonable option. In this case, you cannot take a detour. 

Stopping Your Route
If you want to stop your current route, return to the Menu page 
and touch Stop. 
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FIND IT AND GO!

Adjusting the Volume
Turn the Volume knob on the right side of the unit up to raise the 
volume or down to lower it. 

Adjusting the Brightness
From the Menu page, touch  to adjust the backlight 
brightness. Touch  to lower the brightness and  to raise it. 
Touch OK when you are done. 

c550 Tips and 
Shortcuts

• To quickly return to the Menu 
page, press and hold Back.

• To extend the battery life, 
turn off GPS when you do not 
need to receive GPS signals. 
Touch  > System > GPS 
Mode > GPS Off.

• For more tips about the 
battery, see page 57. 
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WHERE TO?

Go! Page Options

Touch Go! to create a turn-by-
turn route to this location. 

Touch Show Map to view this 
location on the map. 

Touch Save to save this location 
as one of your Favorites. See 
pages 9 through 12 for more 
information. 

If a cell phone with Bluetooth 
wireless technology is connected, 
touch  to call this location.

WHERE TO? 
The Where To? menu provides several different categories used 
to search for locations. From the Menu page, touch Where To? 
To learn how to perform a simple search using the  Where To 
menu, see page 1. 

Address—enter the house number and street name to find a 
specific address. See page 3. 

Go Home—navigate a route to your Home Location. 

Food, Hotel…—search for places such as schools, shopping 
centers, and hospitals. Touch  and  to view all of the 
categories. 

Recently Found—find places you have recently found. 

Favorites—save and find your favorite locations. See page 7

Extras—find optional items such as Custom POIs and Garmin 
Travel Guide™ points. See page XX and XX. 

Intersections—find the intersection of two streets. 

Cities—find a city. 

Browse Map—use the map to find the location you are looking 
for. See the next page. 
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WHERE TO?

Finding an Address
To find an address, touch  Where to? from the Menu page. Touch  Address. 

  Finding an intersection is very similar to finding an address. 
Touch Intersection and enter the two street names. 

Touch a state.

➊

Type the number 
of the address and 
touch Done. 

➍➌

Touch a city.

➎

Type the street 
name and touch 
Done.

➏

Touch the street. Touch the address, if 
necessary. Touch Go!

➐

Touch Spell City 
and spell the city. 

➋



Garmin © 2005 8 c550 Owner’s Manual

WHERE TO?

Go Home
You can set a Home location for the place you return to most often. After you have set your Home, you can 
easily Go Home.

Touch an option. 

➌

Touch Go Home.

➋

Touch  Where to?.

➊

Going Home
Once your Home location is set, you can route to it at any time by touching Where To? > Go Home.

Changing Your Home Location
To change your Home Location, you must first delete it from Favorites: from the Menu page, touch 
Where To? > Favorites > HOME > Edit > Delete > Yes. (For information about editing and deleting 
a saved location from your Favorites, see page 15.) After you delete your Home Location, reset it following 
the steps above. 
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WHERE TO?

Finding Points of Interest
To find a point of interest (such as a restarant, hotel, or 
attraction), touch  Where to? from the Menu page. Touch 

 Food, Hotels…. Touch a sub-category (such as Food) to find 
the location. 

Finding a Place by Spelling the Name 
From the Menu page, touch  Where to? >  Food, 
Hotels… > Spell Name.

Using the on-screen 
keyboard, enter letters 
contained in the name. 
Touch Done.

➊

Touch the place 
you want to visit. 
Touch Go!

➋

✔
 TIP: In any search results 

list, if you do not see the 
place you want visit or 
you want to narrow your 
search results list, touch 
Spell and enter the name 
or part of the name. 

Using the On-Screen Keyboard
Touch  to enter numbers. Touch  to delete the last character entered; touch and hold  to 
delete the entire entry. 

Touch  to change the keyboard mode to use diacritical characters or special characters.
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WHERE TO?

Finding Recently Found Places
Your c550 stores the last 50 of your recent finds in the Recently 
Found list. The most recently viewed places appear at the top of 
the list. From the Menu page, touch  Where to? > Recently 
Found to view your recently found items. 

Deleting Recently Found Places
To remove all places from the Recently Found list, touch Clear. 
Then touch Yes. 

➊ ➋ NOTE: When you touch 
Clear, all items from the 
list are removed. It does 
not delete the actual place 
from your unit.
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WHERE TO?

Finding a Place Using the Map
Use the Browse Map page to view different parts of the map. 
Touch Where to? >  > Browse Map. 

Tips for Browsing the Map
• Touch the arrows to view different parts 

of the map. 

• Touch  and  to zoom in and out. 

• Touch any object on the map. An arrow 
appears pointing at the object you 
selected. 

• Touch Go to navigate to the selected location. 

• Touch Save to save this location to your Favorites. 

• Touch Back to return to the previous screen.

• To save your current location, touch Where to? >  > 
Browse Map. The Browse Map page opens with your current 
location selected. Touch Save to save your current location in 
Favorites.

• If the GPS is off, touch Set Loc. to set your location to the 
selected location. 

Viewing Places on  
the Map

You can view a place you have 
found on the Map page. 

Touch Show Map.

➊

Touch Back, Save, 
or Go! 

➋
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WHERE TO?

Expanding Your Search

From the Menu page, 
touch  Where to? 
Then touch Near.

➊

Touch an option. 
Touch OK.

➋

Where I Am Now—searches for places near your current 
location. 

A Different City—searches for places near the city you enter. 

My Current Route—searches for places along the route you are 
currently navigating.

My Destination—searches for places near your route 
destination.

 NOTE: Your c550 
automatically searches for 
places near your current 
location. 
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FAVORITES

FAVORITES 

Saving Places You Find

➊

After you have 
found a place, 
touch Save. 

➋

Touch OK. 

Finding Saved Places
From the Menu page, touch  Where to?.

Touch Favorites. Touch the place 
you want to visit.

➋➊

Saving Your 
Current Location

Touch the vehicle icon on the 
map. Touch Yes. 
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FAVORITES

Editing Saved Places
After you save a place, you can change the name of the place and 
its symbol on the map. From the Menu page, touch  Where to?

Touch Favorites. 

➊

Touch the Edit button. 
The Edit window opens.

➍

Touch a button edit 
the saved location. 

➌

Touch the place 
you want to edit.

➋

Deleting Saved Places
To delete this saved place, touch Delete. Then touch Yes. 

Changing the Name
To change the name, touch 
Change Name. Enter the 
new name using the on-screen 
keyboard. Touch Done. 

Changing the Map 
Symbol

To change the symbol used on 
the map, touch Change Map 
Symbol and touch a symbol from 
the list. 

Changing the Phone 
Number

You can save a phone number 
for this location to use with your 
Bluetooth® enabled cellular 
phone. Touch Change Phone 
Number, enter a phone number, 
and touch Done. 
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VIEWING THE MAP PAGE AND OTHER PAGES

VIEWING THE MAP AND OTHER PAGES

Viewing the Map Page 
From the Menu page, touch  View map to open the Map page. The position icon  shows your 
current location. Touch areas of the page to see additional information, as described below.

Touch Arrival or 
Speed to open the Trip 
Information page. See 

page 14.

Map Page while Navigating a Route

When navigating, touch 
Turn In to open the Next 
Turn page. See page 15.

When navigating, touch 
the text bar to open the 
Turns List. See page 15.

Touch  to zoom out.

Touch  to zoom in.

Touch Menu to return to 
the Menu page.

When you are following a route, your Arrival time is displayed in the lower left corner. The distance to the 
next turn (Turn In) is shown in the lower right corner. 

When you are simply driving while viewing the Map page (not following a route), your Speed is shown in 
the lower left corner. The direction you are heading (Driving) is shown in the lower right corner. 



Garmin © 2005 16 c550 Owner’s Manual

VIEWING THE MAP PAGE AND OTHER PAGES

Trip Information Page
The Trip Information page displays your current speed and provides helpful statistics about your trip. To 
view the Trip Information page, touch Speed or Arrival on the Map page. 

Current direction 
of travel

Distance traveled 
(Odometer)

Distance to your final 
destination

Trip Information Page

Resetting Trip Information
If you want accurate trip information, reset the trip information before beginning a trip. If you make 
frequent stops, leave the c550 turned on so it can accurately measure elapsed time during the trip. 

Touch Reset Trip to reset the information on the Trip Information page. Touch Reset Max to reset the 
Maximum Speed.
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VIEWING THE MAP PAGE AND OTHER PAGES

Turn List
The Turn List displays turn-by-turn instructions for your entire route. Touch the green text bar on the top 
of the Map page to open the Turn List. This page displays all turns in the route and the distance between 
turns. Touch a turn on the list to view the Next Turn page for that turn. Touch Show Map to view the 
entire route on the Browse Map. 

Turn List

Direction of  
the turn

Distance to  
the turn

Upcoming turn

Distance to the 
upcoming turn

Approximate time 
left until this turn

Next Turn Page

Next Turn Page
The Next Turn page shows the turn on the map and the distance and time left before you reach the turn. 
To view an upcoming turn on the map, touch Turn In on the Map page, or touch any turn from the Turn 
List. 

Use the up and down arrows to view other turns in the route. When you are finished viewing the Next Turn 
page, touch Back.
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MANAGING FILES ON YOUR C550

MANAGING FILES ON YOUR C550
Your c550 is able to store files, such as MP3 and JPEG files. After 
you connect your c550 to your computer, you can copy and paste 
files to the memory or SD Card. Follow the four steps described 
below and on the next page.

NOTE: The c550 is not compatible with Windows 95, 
Windows 98, or Windows Me Operating Systems. This is a 
common limitation of most USB Mass Storage devices. 

Step 1: Insert an SD Card (Optional)
The SD card slot is located on the side of the c550. To insert or 
remove the card, press it in until it clicks. 

Step 2: Connect the USB Cable
1. Plug the small end of the USB cable into the mini-USB 

connector located on the side of your c550. 
2. Connect the larger end of the USB cable to an available 

USB port on your computer. 

Inserting an SD Card

Connecting the USB Cable

NEW IMAGES
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MANAGING FILES ON YOUR C550

Step 3: Transfer Files to Your c550
1. Connect the c550 to your computer as described on the previous page. 
2. Double-click the My Computer icon  on your computer’s desktop. 
3. Browse your computer for the file you want to copy. 
4. Highlight the file and select Edit > Copy. 
5. Open the “Garmin” drive or the SD card drive (see the next page for information).
6. Select Edit > Paste. The file then appears in the list of files on the c550 memory or SD card. 

c550 
Removable 
Disk Drives
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MANAGING FILES ON YOUR C550

Step 4:  Eject and Unplug the USB 
Cable

When you are finished transferring files, double-click the Unplug 
or Eject  icon in your system tray. Select USB Mass Storage 
Device and click Stop. Select the c550 drives and click OK. You 
can unplug the USB cable from your c550 now. 

Information about Your c550 Drives
After you connect your c550 to your computer, one or two 
additional drives appear in your computer’s list of drives. 
“Garmin” is the available storage in the c550’s internal memory. 
The other Removable Disk Drive is the SD card inserted in your 
c550. 

NOTE: On some Windows Operating Systems, the c550 
drives may not be named automatically. See your Windows 
help file or page 56 of this manual to learn how to rename 
the drives. 

Additional Help
For troubleshooting tips for using 
the c550 with your computer to 
transfer files, see page 55.
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MANAGING FILES ON YOUR C550

Deleting Files from Your c550
You can delete files from your c550 just as you would delete files 
from your computer.

With the c550 connected to your computer, open My Computer. 
Open your “Garmin” or  the SD card drive. Highlight the file that 
you want to delete and press the Delete key on your computer’s 
keyboard. 

Supported File Types
• MP3 music files

• JPEG and JPG image files for customized splash screen (see 
page XX)

• GPI custom POI files from Garmin’s POI Loader (see page 51)

• GPX waypoint files from MapSource (see page 54)

• Maps from MapSource

NOTE: The c550 does not support iTunes M4A/M4P files. 

CAUTION: If you are 
not sure about a file’s 
purpose, do NOT delete 
it. Your c550 memory 
contains important map 
data files that should NOT 
be deleted. Be especially 
cautious of files located in 
folders entitled “Garmin.”
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LISTENING TO MUSIC

LISTENING TO MP3 FILES

From the Menu page, touch .

Touch Back to exit the 
MP3 page to view other 
pages, such as the map. 

➍

To play the songs from 
the top of the list, touch 
Play All or touch the song 
you want to start with.

➌

Touch a category. 

➋

Touch Browse.

➊

Playing Music
Touch  to select an equalizer 
setting appropriate for the type of 
music you are listening to. 

Tap  to go to the beginning of 
the song; touch and hold to skip 
back. 

Tap  to skip to the end of 
the song; touch and hold to skip 
ahead. 

Touch  to pause the song. 

Touch  to repeat. 

Touch  to shuffle. 

Touch the album art to view 
details about the MP3 file.

 NOTE: The c550 plays MP3 files only: it does not 
support iTunes M4A/M4P files. 
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USING THE HANDS-FREE FEATURES OF YOUR C550
Your c550 can connect to a cellular phone that has Bluetooth wireless technology to allow hands-free 
communication with full user interface. First, you must pair (connect) the phone with the c550. 

We recommend that you use the settings in your phone to connect to the c550. You might need to initiate 
a connection to the c550 through your phone’s “Bluetooth” settings. For more information, please refer to 
the documents that came with your phone. 

Connecting Your Phone to the c550 Using BlueTooth
Use the settings in your phone to pair with (connect to) the c550. You might need to initiate a connection 
to the c550 through your phone’s “Bluetooth” settings. For more information, refer to the documents that 
came with your phone. 

NOTE: The c550’s PIN code (or passkey) is 1234.

After your phone is paired with the c550, the phone icon appears on the Menu page. Touch  to access 
the Phone menu and make a call. 

Each time you turn on your c550, it automatically attempts to pair with the last phone that it paired with. 
If you want to pair with a different phone, you can initiate a search for available devices from the c550 or 
initiate pairing from the phone if the c550 is not already paired with a different phone. 

When your phone is paired with your c550, a phone icon  is displayed on the Menu page. Touch the 
icon to open the Phone menu to place calls and review your call history. 



Garmin © 2005 24 c550 Owner’s Manual

USING THE PHONE FEATURES

Getting a Call
When a call is being received, a window opens, allowing you to 
answer the call. Touch Answer to answer the call. Touch Ignore 
not answer the call and stop the phone from ringing. 

In A Call
While you are on the phone, an icon floats in the upper right 
corner of the screen. Touch the icon to open the In Call Menu. 
Touch End Call to hang up.

➊

➋
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➊

➋

Phone Menu
Press Status to view the signal strength and the name of the 
connected phone.

Using Your Phone Book
If your cell phone supports phone book transfer, each time your 
cell phone pairs with the c550, the phone book is automatically 
loaded into the c550.  This way, each change you make to your 
cell phone’s phone book is reflected each time you use it with your 
c550. 

 NOTE: After your phone is paired with the c550, it may 
take a few minutes for the phone book to be available. 

1. From the Menu page, touch . 
2. Touch Phone Book. 
3. Touch the phone book entry you want to call. The call is 

placed to the phone book entry you touched. ➌
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USING THE PHONE FEATURES

Dialing POIs
You can place a call to the POIs (points of interest) in the detailed 
maps. 

To dial a POI:
1. From the Menu page, touch . 
2. Touch POI Dial. 
3. Use the Find menu (Where To? menu) to search for the 

POI you want to call. 
4. Enter the number, and touch Dial. 

Dialing Numbers
You can dial a number at any time, just as you can with your cell 
phone., 

To dial a number:
1. From the Menu page, touch . 
2. Touch Dial Number. 
3. Enter the number, and touch Dial. 
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Placing Calls Using Voice Dial
If your cell phone supports it, you can place calls by speaking the 
contact’s name. 

To make a call using Voice Dial:
1. From the Menu page, touch . 
2. Touch Voice Dial. 
3. Speak the contact you want to call.

 NOTE: You may need to “train” your cell phone to 
recognize your voice commands. If so, the c550 will walk 
you through the process. Refer to your phone’s owner’s 
manual, if necessary.  

Viewing Your Call History
Each time you pair your phone with the c550, your call history 
is automatically transferred to the c550. You can then view the 
missed, dialed, and received calls for your cell phone. 

From the Menu page, touch Phone > Call History. Touch a 
category (Missed, Dialed, or Received) to view those calls. The 
calls are listed in chronological order; the most recent calls are at 
the top of the list. To call one of the numbers listed, touch it. 

Why Should I pair my 
phone to my c550?  
Use the c550 as your cell phone 
interface. 

If you have a cellular phone that has 
Bluetooth® wireless technology, you 
can use your c550 as a hands-free 
device. The internal microphone 
in your c550 easily picks up your 
voice; simply talk toward the front 
of the unit. You can also hear the 
phone call through the c550’s 
speakers; use the Volume knob on 
the right side of the c550 to adjust 
the volume. 
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FM TMC TRAFFIC INFORMATION 
Your c550 can use an FM TMC Traffic Receiver to receive traffic 
information broadcast over the FM Radio Data System. When 
a traffic message is received, your unit displays the event on the 
map and can change your route to avoid the traffic incident.  For 
participating subscription providers and coverage areas, refer to 
the Garmin Web site at http://www.garmin.com/fmtraffic. 

Connecting the FM Traffic Receiver
The GTM 20 provides power to the c550 as well as traffic 
information.

1. Plug the power connector into the back of the c550. 
2. Plug the other end into a 12-Volt receptacle in your 

vehicle. 

To power connector on 
c550.

To 12-Volt receptacle in 
vehicle.

Power connector

 NOTE: You can only 
access the traffic 
information and settings if 
the c550 is connected to an 
FM Traffic Receiver. 

 NOTE: The FM Traffic 
Receiver and c550 must 
be in data range of an 
FM station transmitting 
TMC data to receive traffic 
information. 

 NOTE: Garmin is not 
responsible for the 
accuracy of the traffic 
information. The FM 
Traffic Receiver simply 
receives signals from the 
traffic service provider and 
shows that information on 
your c550.

http://www.garmin.com/fmtraffic
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Avoiding Traffic
The map page displays a  when there is a traffic event on your current route or on the road you are 
driving. When you are following a route, touch the  to avoid the traffic. 

➋ ➌➊

From the map 
page, touch .

Touch Avoid.Touch an item to 
view details.

Viewing Traffic Events

➋

Touch an item to 
view details.

➌

Touch an option.

➊

From the Menu 
page, touch .
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Adding a Subscription
Your FM TMC Traffic Receiver may have a trial subscription, or you may be in an area with free 
service. You can also add subscriptions to expand your service area. You will need your FM TMC Traffic 
Receiver’s Unit ID; see below for directions. Go to http://www.garmin.com/fmtraffic to purchase a traffic 
subscription and obtain a 25-character traffic subscription code. 

➍ ➎ ➏

➌➊ ➋

Touch  > 
Traffic.

Touch Add. 

Touch Done.Enter the code and 
touch Done.

Touch Next. 

From the Menu 
page, touch .

http://www.garmin.com/fmtraffic
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CUSTOMIZING THE C550
To change c550 settings, touch  on the Menu page. See the 
following pages for more information.

Touch  to display 
the Settings menu.

➊

Touch the setting 
you want to change. 

➋

Restoring Settings
To restore all settings you have 
changed, press the Restore 
Settings button, as shown below. 

To restore settings for an 
individual category, such as Map, 
touch the Restore Settings button 
on that particular page. 
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Changing the Map Settings
Map Detail—adjust the amount of detail shown on the map. 
Displaying more detail causes the map to redraw slowly. 

Map View—change the perspective of the Map page. 

• Track Up—display the map in 2 dimensions (2D) with your 
direction of travel at the top.

• North Up—display the map in 2D with North at the top.

• 3D—display the map in 3 dimensions (3D), Track Up 
orientation. This is the default map view.

Vehicle—touch Change to change the icon used to display your 
position on the map. Touch the icon you want to use. 

Map Info—view the maps loaded on your c550 and their version. 
Touch a map to enable (check mark present) or disable (check 
mark not present) that map. 

Restore—restore the original map settings.

➊

➋

➌
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Changing the System Settings
GPS Mode—enable and disable GPS and WAAS/EGNOS. Select 
Normal for normal GPS (no WAAS or EGNOS). For information 
about WAAS and EGNOS, go to http://www.garmin.com/
aboutGPS/waas.html.

Safe Mode—turn on or off the Safe Mode feature. When your 
vehicle is moving, Safe Mode disables all unit functions that 
require significant operator attention and could become a 
distraction while driving. 

Proximity Alarms—turn on or off the alerts when you approach 
Custom POIs. This option is only visible if you have loaded 
Custom POIs. See page 51 for more information about Custom 
POIs. 

About—display your c550’s software version number, unit ID 
number, and audio version number. This information is needed 
when you update the system software (see page 53) or purchase 
additional map data (see page 54).

Restore—restore the original system settings.

➊

➋

➌

http://www.garmin.com/aboutGPS/waas.html
http://www.garmin.com/aboutGPS/waas.html
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Localizing Your c550
View the location settings, such as language and time zone. Touch 
Change to adjust the settings. In each screen, touch the setting 
you want, and then touch OK. 

Locale—select your location.

Text Language—change all on-screen text to the selected 
language. Changing the Text Language does not change the 
language of map data, such as street names and places or user-
entered data. 

Voice Language—change the language for all voice prompts 
and messages. Your c550 contains two different types of voice 
languages: text-to-speech and pre-recorded. 

Languages noted with a person’s name are text-to-speech 
(TTS) voices: for example, American English-Jill is a text-to-
speech voice. The text-to-speech voices “read” and “speak” the 
same words that are displayed on the c550. The voices have an 
extensive vocabulary, and they pronounce the street names as 
you approach turns. 

The pre-recorded voices have a limited vocabulary and do not 
speak names of locations or streets. 

➊

➋

➌

➍
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Time Zone—select a time zone or nearby city from the list. 

Daylight Saving—set to On, Off , or Auto if it is available.

Time Format—choose a 12-hour, 24-hour, or UTC time format.

Units—Change units of measure to kilometers (Metric) or miles 
(Statute). 

➊

➋

➌
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Customizing the Display
Color Mode—select Daytime for a light background, Nighttime 
for a black background, or Auto to automatically switch between 
the two. 

Splash Screen—select an image to be shown when you turn 
on the c550. First, load JPEG images on your c550 or SD card 
using USB Mass Storage Mode. See pages 19 through 22 for more 
information about loading files to your c550 or SD card. 

Screen Shot—enable Screen Shot mode. Touch the camera icon 
 to take a picture of the screen. The picture bitmap file is saved 

in XXX. 

➊

➋

➌
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Changing the Navigation Settings
Route Preference—select a preference for calculating your 
route. Select Faster Time to calculate routes that are faster to drive 
but can be longer in distance. Select Shorter Distance to calculate 
routes that are shorter in distance but can take more time to drive.

Vehicle—specify your vehicle type to optimize routes. 

Avoidances—touch the Enabled button 
select the road types you want to avoid on 
your routes. The c550 uses these road types 
only if alternative routes take you too far 
out of your way or if no other roads are 
available. If you have an FM TMC Traffic 
Receiver, you can also avoid traffic incidents.

Attention Tone—turn on or off the attention tone.

Restore Settings—restore the original navigation settings.

➊

➋

➌
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Changing the Bluetooth Settings
Connections—select a device to connect to. Select Add Device 
to search the area for cellular phone with Bluetooth® wireless 
technology. Set your cell phone to Find Me, Discoverable, or 
Visible, and then touch OK. The c550 searches for all Bluetooth 
wireless devices in the area and lists them. Select your phone, and 
then touch OK. Enter the c550’s PIN in your phone. 

 NOTE: The c550’s PIN code (or passkey) is 1234.

Bluetooth—enable and disable the Bluetooth component. 

Friendly Name—select to enter a friendly name that identifies 
your c550 on devices that are Bluetooth  enabled. Touch Done 
after you have entered the name. 

Drop—disconnect the c550 from your phone. 

Clear—delete all Bluetooth devices from the c550’s memory. After 
you clear the devices from the c550, you must pair all devices with 
the c550 as if it is the first time.

Restore—restore the original Bluetooth settings. Restoring the 
Bluetooth settings will not clear the pairing information. 

➊

➋

➌
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Using the Travel Guide
Much like a paper travel guide, the Garmin Travel Guide provides detailed information about places, such 
as restaurants and hotels. Your nüvi comes with a few sample travel guide points; to purchase the Travel 
Guide accessory, go to the Garmin Web site at http://www.garmin.com/products/nuvi/ and click the 
Accessories link. You can also contact your Garmin dealer to purchase nüvi accessories. From the Menu 
page, touch  > Touch  Travel Guide. 

Touch a category. 
Touch a sub-category, 
if necessary.

➌

Touch an item.

➍

➊

Touch Browse.

Touch the arrows to 
view more information 
about the location. 

➎

➋

Touch a location.

Touch Go to go to the location. 
Touch Map to display this item 
on a map. 

➏

http://www.garmin.com/products/nuvi/
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CAUTION: Garmin is 
not responsible for the 
consequences of using a 
custom POI database or 
the accuracy of the safety 
camera or other custom 
POI database. 

Custom POIs (Points of Interest)
Your c550 accepts custom points of interest (POI) databases, 
available from various companies on the Internet. Some custom 
POI databases contain alert information for points such as safety 
cameras and school zones. Your c550 can notify you with a 
proximity alarm when you approach one of these points.

After downloading your POI database, use the Garmin POI Loader 
to install the POIs into your unit. The POI Loader is available at 
http://www.garmin.com/products/c550 and click Updates and 
Downloads. 

Using the POI Loader program, you can store the Custom POIs on 
your “Garmin” drive or your SD card. You can also customize the 
proximity alert settings for each POI using the POI Loader. Refer 
to the POI Loader Help File for more information; press F1 to 
open the Help File. 

To view your Custom POIs, touch Where To? > Extras > 
Custom POIs. 

To delete the Custom POIs from your c550, connect your c550 to 
your computer. Open the “Garmin” drive or the SD Card drive. 
Locate the folder called “POI” in the folder called “Garmin.” Delete 
the file entitled “poi.gpi.”

Adjusting the  
Proximity Alarms

To turn on or off the proximity 
alarms, from the Menu page, 
touch  > System > 
Proximity Alarms. 

When the Proximity Alarms are 
on, your c550 chimes when you 
approach a Custom POI. 

http://www.garmin.com/products/nuvi/
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APPENDIX

Mounting Your c550
Select a suitable location to mount the c550 on your windshield. Clean and dry the selected area of your 
windshield. 

1. Place the suction cup on the windshield. 
2. Flip the lever back, toward the windshield. 
3. Plug the power cable into the back of the c550. Plug the other end into a  

12-Volt receptacle in your vehicle. Your unit may turn on automatically if  
you have started your vehicle.

Warning: For use in vehicles, it is the sole responsibility of the owner/operator of a vehicle with the c550 installed to 
place and secure the device so it will not interfere with the vehicle operating controls and safety devices, obstruct the 
driver’s view of driving conditions, or cause personal injury in the event of an accident.

➊

➋

windshield

➎
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Removing the c550 and the Mount
The c550 and the mount snap apart and together. To remove the mount from the c550, turn the mount 
as far as you can to the right or left. Apply pressure in that direction until the mount pops out of the ball 
socket. 

To remove the suction cup from the windscreen, flip the lever toward you. Pull the tab on the suction cup 
toward you.

Mounting the c550 on Your Dashboard
Use the enclosed mounting disk to mount your unit to the dashboard. California drivers, use the enclosed 
disk to comply with California regulations: see the c-series Product Information Sheet that came in the 
box for more information. 

Important: The permanent mounting adhesive is extremely difficult to remove after it is installed. 

To install the mounting disk:
1. Clean and dry the dashboard where you will place the disk.
2. Remove the backing from the permanent mounting adhesive on the bottom of the disk
3. Place the disk on the dashboard.
4. Place the suction cup mount on top of the disk and flip the lever down (toward the disk).

Disk

Suction 
cup mount

Lever
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Resetting Your c550
If your unit locks up (freezes up), press the Power button to turn 
off the unit, then press again to turn the unit back on. If this does 
not help, reset your c550. 

To reset the c550:
1. Place your thumb nail in the groove located under the 

Garmin logo on the face plate. 
2. Gently pull off the face plate. 
3. Press the Reset button. 
4. Turn the unit back on; it will operate normally.

Reset button

Power buttonFace plate

Clearing User Data
Hold your finger on the lower 
right corner of the c550’s screen 
while turning on the c550. Keep 
your finger pressed until the pop-
up window appears. Touch Yes to 
clear all user data. 

All original settings are restored. 
Any items that you have saved are 
erased. 



Garmin © 2005 44 c550 Owner’s Manual

APPENDIX

Caring for Your c550 
Your c550 contains sensitive electronic components that can be permanently damaged if exposed to 
excessive shock or vibration. To minimize the risk of damage to your c550, avoid dropping your unit and 
operating it in high shock/vibration environments.

Cleaning the Unit
The c550 is constructed of high quality materials and does not require user maintenance other than 
cleaning. Clean the unit’s outer casing (not the touch screen) using a cloth dampened with a mild detergent 
solution and then wipe dry. Avoid chemical cleaners and solvents that can damage plastic components.

Cleaning the Touch Screen
Clean the touch screen with a soft, clean, lint-free cloth. Use water, isopropyl alcohol, or eyeglass cleaner, 
if needed. Apply the liquid to the cloth and then gently wipe the touch screen.

Protecting Your c550
Follow the cautions below to protect your c550 from damage:

• Do not store the c550 where prolonged exposure to extreme temperatures can occur (such as in the 
trunk of a car), as permanent damage may result. 

• Do not expose the c550 to water. Contact with water can cause this unit to malfunction.
• Do not leave your c550 in plain sight when you leave your vehicle. Take your unit with you or remove it 

from view to avoid theft.
• Though a PDA stylus can also be used to operate the touch screen, never attempt this while operating a 

vehicle. Never use a hard or sharp object to operate the touch screen or damage may result. 
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Using the c550 Indoors
Turn off GPS (  > System > GPS Mode > GPS Off) and use your c550 indoors. Use this setting 
when do not need GPS satellite signals, such as when you are practicing or using the MP3 player. 

Using a Remote Antenna
You can use an optional external remote antenna (Garmin GA 25MCX). This is very helpful when 
operating the unit in a vehicle with a coated windshield or an in-screen (in the window) heating system, 
which can block GPS signals. Remove the weather cap from the antenna connector located on the left side 
of the c550 and connect the antenna. To purchase, go to the Garmin Web site at http://www.garmin.com/
products/c550 and click the Accessories link. 

Changing the Fuse
An AGC/3AG 2 Amp, high-breaking capacity, 1500 A-rated fuse is located at 
the tip of the vehicle adapter. Periodically, you may need to change the fuse. 
Unscrew the black, round end piece and replace the fuse. 

Charging the c550
You can charge the c550 using the 12/24-Volt car adapter connected to the suction mount. 

Unscrew

http://www.garmin.com/products/nuvi/
http://www.garmin.com/products/nuvi/


Garmin © 2005 46 c550 Owner’s Manual

APPENDIX

Updating the c550 Software
If you register your c550, you will receive notification of software and map updates. To register your c550, 
go to https://www.garmin.com/registration/selectreg.jsp. 

To update the c550 software:
1. Connect the USB cable to your c550 and your computer. See the previous page.
2. Go to http://www.garmin.com/products/sp550. Click Software Updates. 
3. Click Download next to the unit software. 
4. Read and agree to the terms. Click Download. 
5. Select Run (or Open). Your software is updated.
You can also use WebUpdater to update your c550 software. Go to http://www.garmin.com/products/
webupdater/ to learn about WebUpdater.

Purchasing and Loading Additional MapSource Maps
Check http://www.garmin.com/unlock/update.jsp to see if an update for your map software is available. 
To find out the version of the maps that are loaded on your c550, open the Menu page. Touch  > Map 
> Map Info. You can also purchase additional MapSource map data from Garmin and load the maps on 
your c550’s internal memory or on an optional SD card. 

Follow the instructions that came with the new map data to properly install the maps to your computer 
and c550. In order to enable additional maps, you need your unit ID (see page 38) and serial number (see 
page i). To load maps to your c550 memory or SD card, select the name for your “Garmin” drive or SD card 
drive. Refer to the MapSource help file for more information about using MapSource and loading maps on 
your Garmin GPS. 

https://www.garmin.com/registration/selectreg.jsp
http://www.garmin.com/products/sp2720/
http://www.garmin.com/products/webupdater/
http://www.garmin.com/products/webupdater/
www.garmin.com/unlock/update.jsp
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Loading MapSource Waypoints on Your c550
Using MapSource, you can save locations (also called waypoints) and transfer them to your c550. For more 
information about creating waypoints in MapSource, see the help file (press F1 to open the help file). 

After you have created the waypoints, select File > Save. Select GPS eXchange Format (*.gpx) for the 
Save as Type. Click the Save button. 

With your c550 connected to your computer, copy the *.gpx file into in the Garmin\Waypoints folder in 
the “Garmin” drive. The waypoints you created in MapSource are now in Where To? > Favorites. 

Viewing Your Saved Locations in MapSource
You can also view the locations you have saved in your c550 using the MapSource program. 

In MapSource, select File > Open. Select GPS eXchange Format (*.gpx) for Files of Type. Browse to 
find the Garmin\Waypoints folder on your “Garmin” drive. Select Waypoints.gpx and click Open. 
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Bluetooth® Wireless Technology Troubleshooting
Problem/Question Solution/Answer

USB Interface Troubleshooting
Problem/Question Solution/Answer

How do I know my c550 
is in USB Mass Storage 
Mode?

When your c550 is in USB Mass Storage Mode, a picture of a c550 
connected to a computer is shown. Also, you should see two new 
Removable Disk Drives listed in My Computer. 

My computer never 
senses that the c550 is 
connected.

1. Unplug the USB cable from your computer. 
2. Turn the c550 off and then back on again. 
3. Plug the USB cable into your computer. The c550 automatically 

turns on and goes into USB Mass Storage Mode. 

I cannot find any drives 
named “Garmin” in my 
list of drives.

Try the solution listed above. 
If you have several network drives mapped on your computer, 
Windows may have trouble assigning drive letters to your c550 
drives. Follow the steps on the following page to assign your drive 
letters. 



Garmin © 2005 49 c550 Owner’s Manual

APPENDIX

Problem/Question Solution/Answer
I keep getting a message 
saying “Unsafe Removal 
of Device” when I unplug 
the USB cable.

When you are ready to disconnect your c550 from your computer, 
double-click the Unplug or Eject  icon in your system tray. Select 
USB Mass Storage Device and click Stop. Select the c550 drives 
and click OK. You can disconnect your c550 from your computer now. 

How can I rename my 
c550 drives?

1. Open My Computer. 
2. Select the drive you want to rename. 
3. Right-click your mouse and select Rename. 
4. Type the new name and press the Enter key on your computer’s 

keyboard. 

How do I map my c550 
drives in Windows?

1. Turn off your c550. 
2. Plug in the USB cable to the c550 and your computer. Your c550 

will automatically turn on. 
3. Click Start > Settings > Control Panel > Administrative 

Tools > Computer Management > Storage > Disk 
Management. 

4. Click a c550 removable disk drive (either the internal memory or 
your SD Card drive). Right-click your mouse and select Change 
Drive Letter and Path….

5. Select Edit…, select a drive letter from the drop-down list, and 
click OK. 



Garmin © 2005 50 c550 Owner’s Manual

APPENDIX

Battery Tips
• Your c550’s battery should 

last 4 to 8 hours depending on 
usage.  

• To extend the battery life, turn 
off GPS (  > System > 
GPS Mode > GPS Off) when 
you do not need to receive 
GPS signals or use Normal 
mode when you do not need to 
use WAAS or EGNOS.

• To extend the battery life, 
turn the backlight brightness 
down (from the Menu page, 
touch  to adjust the 
brightness).

• To maximize the life of the 
lithium-ion battery, do not 
leave your c550 direct sunlight 
and avoid prolonged exposure 
to excessive heat. 

Battery Information 
Your unit contains an internal (non-removable) lithium-ion 
battery. Contact your local waste disposal department for 
information on properly disposing of the unit. 

Battery Gauge
The battery icon in the upper right corner of the Menu page 
indicates the status of the internal battery. If the icon is not 
present, the c550 is connected to external power. 

Battery 3/4 full

Full battery

Battery 1/2 full

Battery 1/4 full
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About Satellite Signals
Your c550 must acquire satellite signals to operate. If you are indoors, near tall buildings or trees, or in a 
parking garage, the c550 cannot acquire satellites. Go outside to an area free from tall obstructions to use 
your c550. 

When the c550 has acquired satellite signals, the signal strength bars on the Menu page are green . 
When it loses satellite signals, the bars turn red or disappear . 

For more information about GPS, visit the Garmin Web site at http://www.garmin.com/aboutGPS.

http://www.garmin.com/aboutGPS
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Technical Specifications
Size: 4.4” W x 3.2” H x 2.8” D

Weight: 9.45 ounces

Display: QVGA transflective TFT color display, bright white LED 
backlight, and touch screen

Temperature: 32°F to 122°F (0°C to 50°C)

Charge Time: Approximately three hours to charge

Data storage: Internal memory and optional Removable SD card. 
Data stored indefinitely

PC interface: USB mass storage, plug-and-play

Power Input: 12/24 VDC

Usage: 15 W max. @ 13.8 VDC

Battery life: 4 to 8 hours depending on usage

Headphone jack: Standard 3.5 mm 

For a complete list of specifications, visit the Garmin Web site at 
http://www.garmin.com/products/c550/spec.html.

GPS Performance 
Specifications

Receiver: WAAS enabled

Acquisition times*: 
Warm: <1 sec 
Cold: <38 sec 
Factory Reset: <45 sec
*On average for a stationary 
receiver with an open sky view

Update rate: 1/sec, continuous

GPS Accuracy:
Position: <10 meters, typical
Velocity: 0.05 meter/sec RMS

GPS (WAAS) Accuracy:
Position: <5 meters, typical
Velocity: 0.05 meter/sec RMS

http://www.garmin.com/products/c550/spec.html
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Software License Agreement
BY USING THE c550, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THE 
FOLLOWING SOFTWARE LICENSE AGREEMENT. PLEASE READ THIS AGREEMENT CAREFULLY.

Garmin grants you a limited license to use the software embedded in this device (the “Software”) in binary 
executable form in the normal operation of the product. Title, ownership rights, and intellectual property 
rights in and to the Software remain in Garmin.

You acknowledge that the Software is the property of Garmin and is protected under the United States of 
America copyright laws and international copyright treaties. You further acknowledge that the structure, 
organization, and code of the Software are valuable trade secrets of Garmin and that the Software in source 
code form remains a valuable trade secret of Garmin. You agree not to decompile, disassemble, modify, 
reverse assemble, reverse engineer, or reduce to human readable form the Software or any part thereof or 
create any derivative works based on the Software. You agree not to export or re-export the Software to 
any country in violation of the export control laws of the United States of America.

NOTE: The Garmin c550 has no user-serviceable parts. Should you ever encounter a problem 
with your unit, take it to an authorized Garmin dealer for repairs. 

NOTE: The c550 is fastened shut with screws. Any attempt to open the case to change or modify 
the unit in any way voids your warranty and may result in permanent damage to the equipment.
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FCC Compliance
The unit complies with Part 15 of the FCC interference limits for Class B digital devices FOR HOME 
OR OFFICE USE. These limits are designed to provide more reasonable protection against harmful 
interference in a residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment 
does cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, you are encouraged to try to correct the interference by one of the following 
measures:

•  Reorient or relocate the receiving antenna.

•  Increase the separation between the equipment and the receiver.
•  Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected.
•  Consult an experienced radio/TV technician for help.

The unit does not contain any user-serviceable parts. Repairs should only be made by an authorized 
Garmin service center. Unauthorized repairs or modifications could result in permanent damage to the 
equipment, and void your warranty and your authority to operated this device under Part 15 regulations.
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About Button 37
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Attention Tone 40
Audio version 37
Avoiding road types 40
Avoiding Traffic 33, 40

B
Battery 51
better route 2
Brightness 5
Browse the Map 12
Browsing the map 12, 14

C
Caring for your nüvi 46
Changing the settings 35
Clearing User Data 44
Computer connection 19
Connecting the USB Cable 19
Contact Garmin i
Current Location, saving 14
Customizing your nüvi 35

map 36

navigation 40
system setup 37

Custom POIs (Points of 
Interest) 45

D
Daylight Saving 39
Delete

character 10
custom POIs 45
files from the nüvi 22
recent finds list 11
saved places 15
user data 44

Detour, adding 4
Disconnecting your nüvi 49
Disk Drives 20, 21
Driving directions 18

E
Editing saved places 

(Favorites) 15
EGNOS 37
Eject USB 20
Expanding your search 13

F
Favorites 14, 15
Files

deleting 22
managing 19
supported types 22

transferring 20
Finding places

address 7
by name 6
intersection 7
item on the map 12
recent selection 11
saved item 14

Find a place near another 
place 13

FM TMC Traffic Receiver 32–
34

Following your route 2
Fuse, changing 47

G
Go! 6
Go Home 8
GPS 5, 51

H
Home Location 8

K
Keyboard 10

L
License Agreement 54
Listening to music 23

M
M4A/M4P 23

Map 12, 16
browse 12
customize 36
zoom 12, 16

MapSource 48
Map Info Button 36
Map software

update 47
version 36

Map symbol 15
Map view 36
Metric units 39
Mounting your nüvi 43
Moving the map 12, 14
MP3 23
My Locations 14

Favorites 14
Recent Selections 11

N
Narrow your results list

spell the name 10
Navigation settings 40
Near Button 13
Next Turn Page 18
North Up 36

O
On-screen keyboard 10

P
Phone Number 15
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Playing Music 23
POI 45
Position icon 16
Present Location, saving 14
Proximity Alarms 37, 45

Q
Quick Settings 5

R
Recently-Found places

delete 11
find 11

Removable Disk Drives 20, 21
Resetting your nüvi 44
Reset Max Speed 17
Reset Trip 17
Restoring Settings 35
Routing preferences 40

S
Safety camera database 45
Safe Mode 37
Satellite Signals 52
Save

places you find 6, 14
Saved Places

delete 15
edit 15

Save Current Location 12
save your current location 12, 

14

School zone database 45
SD Card 19, 53
Serial Number i
Set your Location 12
Shortcuts 5
Show Map 6, 12
Software License Agreement 54
Software version 37
Spell the name of a place 10
Stop navigation 4
Stop USB 20
Storing your nüvi 46
Supported File Types 22
System Setup 37

T
Text Language 38
Touch screen

cleaning 46
Track Up 36
Traffic 32

avoid 33, 40
events 33
subscription 34

Transferring Files 20
Trip Information Page 17
Troubleshooting 50

USB 49
Turn-by-turn directions 18
Turn off the beeping 37

U
Units 39
Unit ID 37
USB 20

troubleshooting 49
User Data, deleting 44
Using the nüvi Indoors 47

V
Vehicle Type 40
Viewing Places on the Map 12
Viewing the Map 16
Voice Language 38
Volume 5

W
WAAS 37–41

Z
Zoom 12, 16



For the latest free software updates (excluding map data)  
throughout the life of your Garmin products, visit the  

Garmin Web site at www.garmin.com.
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